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http://go.grolier.com/
Lenski, Lois (1893-1974), prolfic American writer and llustrator of children’s books for more than 40 years. Lois
Lenore Lenskiwas bor into an educated, religious family in Springfield, Ohio, on Oct. 14, 1893, the fourth of five
children. Her was a Lutheran minister who eventually became dean of the theological seminary at Capital
University in Bexley, Ohio, a suburb of Columbus. Lenski’ ‘had been a schoolteacher before her marriage.
Lenski was raised chiefly in the rural town of Anna, Ohio. Through herparents—who, as she explained in her
1972 autobiography, Journey into Childhood, had strong positive attitudes toward work, learning, and
education—she developedalove of reading, preferring booksto allother gifts at Christmas. i highschool she
discovered Charles Dickens and his vivid word-pictures of "real” people, in which she exulted. Yet herfather's
encouragement to be outspoken n depicting the truth seems to have had an effecton Lenski's own style, which
Is well described by thecritic Anne Scott Macleod as "sober, realistic, and straightforward."
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3. Studentswillfill in their highlighted facts onto their SmartArt graphic organizer. Students can split the computer
screento see boththe highlighted textand the graphic organizer at the same time; they don’t have to toggle
back and forth. If students use a book or print out online information they can type their facts directly onto the
‘SmartArtgraphic organizer. They could also print out the graphic organizer and hand-write the information with

apenor pencilif they choose todo so.
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Sixth Grade AE Author Research Paper Rubric

	Points awarded
	Possible points
	Points per section
	Category

	
	
	
	

	
	
	
	Pasted and highlighted Internet source information onto Word.

	
	1st 10 point  source
	2
	Internet text is copy, paste/special with only text visible. No pictures.

	
	
	2
	Internet source address is pasted at the top of each source.

	
	
	6
	Students highlight facts corresponding to the appropriate subtopic on the graphic organizer.  No more than six words in a row should be highlighted about a particular subtopic.

	
	
	
	

	
	2nd 10 point  source
	2
	Internet text is copy, paste/special with only text visible. No pictures.

	
	
	2
	The Internet source address is pasted at the top of each source.

	
	
	6
	Students highlight facts corresponding to the appropriate subtopic on the graphic organizer.  No more than six words in a row should be highlighted about a particular subtopic.

	
	
	
	

	
	
	
	SmartArt Graphic organizer is filled in.

	
	20
	16
	Each subtopic of the graphic organizer is filled in with no more than six words per bulleted line.

· 2 points per subtopic.  There are eight subtopics. Four subtopics are on page one and the other four subtopics are on page two.

	
	
	4
	The source box underneath each subtopic of the graphic organizer is filled in with the appropriate website address.

	
	
	
	

	
	
	
	Works Cited page and Title Page

	
	15
	5
	Works are alphabetized by first word of the entry.

	
	
	5
	Double spaced.

	
	
	5
	Second and third lines or more of each entry show a “hanging indent.”

	
	
	
	Title Page

	
	5
	5
	Each part of the Title Page is correctly filled in.

	
	
	
	

	
	
	
	Research Paper

	
	10
	10
	Spelling, grammar and transitional words are used correctly.

	
	30
	5
	Introductory paragraph includes topic sentence with the author’s name and famous works.

	
	
	5
	Introductory paragraph includes thesis statement as the last sentence.  The thesis statement lists three reasons why your author is admirable.

	
	
	5
	Paragraph two explains the first reason of the thesis statement with evidence from the graphic organizer.

	
	
	5
	Paragraph three explains the second reason of the thesis statement with evidence from the graphic organizer.

	
	
	5
	Paragraph four explains the last reason of the thesis statement with evidence from the graphic organizer.

	
	
	5
	Concluding paragraph with the thesis statement restated.


Part One!!!

Sixth Grade AE Author Research Paper Overview

FOR STUDENTS

Lynn Murray, TOR LMC

November, 2011

Research paper topic:  Students will choose an author from their Summer Reading and Core Novels list.  They will then read, take notes on the new SmartArt graphic organizer feature of Word 2007, and then create a research paper which answers the question, “Do you admire your chosen author?”  

Possible Author Choices with a Sample Work:

[image: image1.png]Abbott, Tony ireqitl

Anderson, Halse Chains
Avi Strange Happenings

Bauer, Joan Stand Tall

Birdseye, Tom Eye of the Stone
Choldenko, Gennifer Al Capone Shines My Shoes
Clark, Ann Nolan Secret of the Andes
Collins, Suzanne The Hunger Games
Cummings, Priscilla The Red Kayak

Curtis, Christopher Paul Bud_ Not Buddy
DiCamillo, Kate Because of Winn Dixie
Drey, Kathleen Mary Alice Peal

Farmer, Nancy The Ear the Eye and the Am
Fox, Paula The Slave Dancer

Grimes, Nikki Roadto Paris

Grisham, John APainted House

Hale, Shannon The Princess Academy.
Henry, Marguerite: King of the Wind

Hiaasen, Car Hoot

Holm, Jennifer Penny from Heaven
Horowitz, Anthony Alex Rider Stormbreaker
Hughs, Dean Search and Destroy.
Lenski, Lois Strawberry Gil

Martin, Ann M. A Comer of the Universe
McKinley, Robin The Blue Sword

Osborme, Mary Pope Favorite Medieval Tales
Parks, Gordon The Leaming Tree

Patron, Susan Higher Power of Lucky
Patterson, James Maximum Ride

Paulsen, Gary Hatchet

Peck, Richard The Wednesday Wars
Pullman, Phi The Broken Bridge
Sandera, Brandon Alcatraz Versus the Knights

Spinelli, Jerry Maniac McGee




Research steps overview:

1.  Students will locate information about their author from a predetermined list of books and websites.
2. Students will read the information and highlight facts (who, what, where, when and why facts) about their author’s personal and professional life in no more than six words in a row. 

3. Students will take notes about their author using SmartArt, a new graphic organizer program, part of Word 2007.  

4. Students will cite their sources and create a Works Cited page using Easybib.com.

5. Students will create their paper using their SmartArt notes as a reference while they are writing.  Students will split their computer screen as they are composing their paper so their graphic organizer notes are on one side and the blank Microsoft Word document is on the other.

DAY ONE: Students will locate information about their author from a predetermined list of books and websites.
1. Students will locate information about their author from the databases and books available at TOR.

2.  Students will copy and paste/special their Internet information to Word and then copy and paste the website address directly above their pasted information.

3.  Students will save ALL OF THEIR PASTED INFORMATION ONTO ONE Word document.

· Insert>Page Number>Bottom right

· File>Save As>Click on your ID number on the left>Save

Sources:

· Destiny=Media Center online card catalog for books and reliable website information.

At TOR: Internet>Favorites>Destiny Library System

· Click on TOR.

· Click on the Catalog tab.

· Type your author’s name in the Search box. Enter.

· A listing of your author’s books will be listed below.

· Click on the Websites tab in the upper right corner for reliable websites about your author.  How cool!  Look at all of the reliable websites about your author.

· Open a website about your author and if it has biographical information about your author,     
                                 copy>paste/special your Internet information to Word. 

· Internet>Ctrl A>Ctrl C
· Word>Click on the arrow below Paste in the top left corner>Paste Special>Unformatted text.

· Copy and paste the website address on top of your pasted information.  



Outside of TOR you can access Destiny by…
· Toronline.org>Click on Academics>Click on Library Media Center>Link to Media Center>Click on the link on the right side How to Use Destiny, TOR’s Online Card Catalog

· Open up the Word document with directions about how to access Destiny at home.

·  Grolier=Online encyclopedia.

· Internet>Favorites>TRN Online>Bigchalk and ELibrary>Click on Grolier

· Type your author’s name in the Search box. Enter.

· Click on the first link about your author.

· Copy>paste/special your Internet information to Word.

· Copy and paste the website address on top of your pasted information.  (see below)
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http://go.grolier.com/
Lenski, Lois (1893-1974), prolfic American writer and llustrator of children’s books for more than 40 years. Lois
Lenore Lenskiwas bor into an educated, religious family in Springfield, Ohio, on Oct. 14, 1893, the fourth of five
children. Her was a Lutheran minister who eventually became dean of the theological seminary at Capital
University in Bexley, Ohio, a suburb of Columbus. Lenski’ ‘had been a schoolteacher before her marriage.
Lenski was raised chiefly in the rural town of Anna, Ohio. Through herparents—who, as she explained in her
1972 autobiography, Journey into Childhood, had strong positive attitudes toward work, learning, and
education—she developedalove of reading, preferring booksto allother gifts at Christmas. i highschool she
discovered Charles Dickens and his vivid word-pictures of "real” people, in which she exulted. Yet herfather's
encouragement to be outspoken n depicting the truth seems to have had an effecton Lenski's own style, which
Is well described by thecritic Anne Scott Macleod as "sober, realistic, and straightforward."

website address pasted at top:

3. Studentswillfill in their highlighted facts onto their SmartArt graphic organizer. Students can split the computer
screento see boththe highlighted textand the graphic organizer at the same time; they don’t have to toggle
back and forth. If students use a book or print out online information they can type their facts directly onto the
‘SmartArtgraphic organizer. They could also print out the graphic organizer and hand-write the information with

apenor pencilif they choose todo so.
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· Bigchalk and ELibrary=Research database.  Includes book, magazine, and newspaper and Internet information.

· Internet>Favorites>TRN Online>Bigchalk and ELibrary>Click on ELibrary Curriculum Edition

· Type in your author’s name

· Click on the first link about your author.

· Copy>paste/special your Internet information to Word.

· Copy and paste the website address on top of your pasted information.  (see below)
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1972 autobiography, Journey into Childhood, had strong positive attitudes toward work, learning, and
education—she developedalove of reading, preferring booksto allother gifts at Christmas. i highschool she
discovered Charles Dickens and his vivid word-pictures of "real” people, in which she exulted. Yet herfather's
encouragement to be outspoken n depicting the truth seems to have had an effecton Lenski's own style, which
Is well described by thecritic Anne Scott Macleod as "sober, realistic, and straightforward."
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‘SmartArtgraphic organizer. They could also print out the graphic organizer and hand-write the information with
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· Reliable websites:

· Scholastic.com author biographies  http://www.scholastic.com/librarians/ab/biolist.htm
· Simon and Schuster biographies http://www.kidsreads.com/authors/au-avi.asp
· Type in your author’s name

· Click on the first link about your author.

· Copy>paste/special your Internet information to Word.

· Copy and paste the website address on top of your pasted information.  (see below)
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Is well described by thecritic Anne Scott Macleod as "sober, realistic, and straightforward."
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6. DAY TWO:  Students will read the information and highlight the facts (who, what, where, when and why facts) in no more than six words in a row. 

Sample text highlighted with website address pasted at top:

http://go.grolier.com/
Lenski, Lois (1893–1974), prolific American writer and illustrator of children's books for more than 40 years. Lois Lenore Lenski was born into an educated, religious family in Springfield, Ohio, on Oct. 14, 1893, the fourth of five children. Her father was a Lutheran minister who eventually became dean of the theological seminary at Capital University in Bexley, Ohio, a suburb of Columbus. Lenski's mother had been a schoolteacher before her marriage. Lenski was raised chiefly in the rural town of Anna, Ohio. Through her parents—who, as she explained in her 1972 autobiography, Journey into Childhood, had strong positive attitudes toward work, learning, and education—she developed a love of reading, preferring books to all other gifts at Christmas. In high school she discovered Charles Dickens and his vivid word-pictures of "real" people, in which she exulted. 

· Students can split the screen to see what they should highlight.
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Lenski, Lois (1893-1974), prolific American writer and ilustrator of children’s books for more than 40 years. Lo
Lenore Lenski was born into an educated, religious family in Springfield, Ohio, on Oct. 14, 1893, the fourth of five
children. Her father was a Lutheran minister who eventually became dean of the theological seminary at Capital
University in Bexley, Ohio, a suburb of Columbus. Lenski's mother had been a schoolteacher before her marriage.
Lenski was raised chieffy in the rural town of Anna, Ohio. Through her parents—who, as she explained in her
1972 autobiography, Journey into Childhood, had strong positive attitudes toward work, learning, and
education—she developed a love of reading, referring books toallother gitsat Christmas. in high school she
discovered Charles Dickens and his vivid word-pictures of "real” people, in which she exulted. Yet her father's

‘encouragement to be outspoken in depicting the truth seems to have had an effect on Lenski's own style, which

is welldescribed by the critic Anne Scott MacLeod as "sober, realistic. and straightforward.”




DAY THREE: Students will take notes about their author using SmartArt, a new graphic organizer program, part of Word 2007.  

· Split the screen and fill in the graphic organizer below (see pages 5 and 6 below) with highlighted facts from pasted Internet information.

· Copy and paste either the website address or type the ISBN number into the Source box. 
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‘SmartArt Graphic Organizer Sixth Grade Language Arts Research Paper
Biography Research Question: "Do you admire your auther?”

Author’s Name: Author's Early Life  Your name:
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- FatherLuthern minister Mother=schooltzacher. -]
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"Source: Copy and paste your source'swebsite addresshere:

Type your book's ISBN number here:

Influences to
become a writer.

||| (Foeercony snaveme vaursoures e sdaesznere T

of [l |or °

# [[[| [vee vour book's issn number here: =
« [ & R (K1 - ) ¥
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SmartArt Graphic Organizer Sixth Grade Language Arts Research Paper
Biography Research Question:  “Do you admire your chosen author?”
Author’s Name:                        Author’s Early Life     Your name:
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4.  DAY FOUR:  Citing sources.  Students will use the website Easybib.com to create a Works Cited/Bibliography page as the last page of their research paper.  Easybib.com uses the website addresses that students previously copied and pasted as the basis of creating their Works Cited/Bibliography.
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Sample Works Cited page example from Easybib.com, copy and pasted to Microsoft Word:

Works Cited

Harman, Alan. Sheep Magazine | Breeding and Raising Sheep | Sheep Business. Web. 09 May 2011.  



<http://www.sheepmagazine.com/>.

Sheep 101 Home Page. Web. 09 May 2011. <http://www.sheep101.info/>.

   World Book Encyclopedia. World Book, Inc.: Chicago, IL, 2010. Print.

DAY FIVE: Students will create their paper based on the notes from their graphic organizer.  Students can split the screen so their notes are on one side and a blank page is on the other.
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Students can also create the in text citations in their paper by refering to the source box below their subtopics.
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Part Two!!!

Sixth Grade Language Arts Biography 
Research Paper Guidelines for Students!!!!
                                   Lynn Murray  TOR LMC  November, 2011  

A research paper has three separate parts that are stapled together to form one packet:

1.  Title page

2.  The research paper.
3.  The Works Cited page.  (The Works Cited page was previously called the Bibliography.   Works Cited includes both book and computer sources; a bibliography just includes a listing of book sources.)

Research process review:

7.  Students will locate information about their author from a predetermined list of books and websites.

8. Students will read the information and highlight facts (who, what, where, when and why facts) about their author’s personal and professional life in no more than six words in a row. 

9. Students will take notes about their author using SmartArt, a new graphic organizer program, part of Word 2007.  

10. Students will cite their sources and create a Works Cited page using Easybib.com.

11. Students will create their paper using their SmartArt notes as a reference while they are writing.  Students will split their computer screen as they are composing their paper so their graphic organizer notes are on one side and the blank Microsoft Word document is on the other.
Part 1: Title page requirements:

A. Open the attachment entitled “Sample Title Page to fill in.” 
· File>Open>sharedw>TOR Library/Media Center>Colleran Language Arts Research  Paper>Sample Title Page to Fill in
B. Fill in the title of your paper and your name.
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Part 2: Research paper requirements:
A.  Formatting requirements:
· Open a new blank Word document.( Ctrl N)
· Double spaced and Times New Roman, 12 font.
· Ctrl A>Click here on the double headed arrow>Click on 2.0.
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· Insert page numbers in the bottom right corner.
· Insert tab at top>Page number>Bottom of page>Plain Number 3 [image: image15.png]Home
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Then, click on Close Header and Footer at the top  
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B.  Research paper requirements.  
· Your paper will answer the question, “Do you admire your chosen author?” 
· (Admire means to regard with wonder, pleasure, or approval.)
· You will use your notes from your graphic organizer as evidence to answer this question.
Possible reasons that you may admire your chosen author could include:

· They had an extensive educational background. 

· They had an interesting childhood.

· They are prolific (have written a lot of books).

· They’ve led an exemplary (outstanding) life.

· They’ve overcome formidable obstacles (problems).

· Many people enjoy their books because of their uniqueness.

· The themes of the books are interesting.

· They have a love of writing that’s inspiring to others.

· They didn’t initially start off as a writer and something changed their mind.
· Your own reason.
(Please note that a research paper is written using the third person.  You do not use “I” when you are writing this paper.)


Research paper paragraph outline:

Your paper will consist of five paragraphs=
Paragraph 1=Introductory paragraph=Topic sentence + thesis statement 
· The thesis statement is the last sentence of your introductory paragraph and includes three reasons as to why your author is admirable.
Paragraph 2= You will explain the first reason of your thesis statement as to why you admire your chosen author.  Use evidence from your graphic organizer to support your reason.

Paragraph 3=You will explain the second reason of your thesis statement as to why you admire your chosen author.  Use evidence from your graphic organizer to support your reason.

Paragraph 4=You will explain the third reason of your thesis statement as to why you admire your chosen author.  Use evidence from your graphic organizer to support your reason.

Paragraph 5=Concluding paragraph.  Restate your thesis statement.
Research paper paragraphs described in more detail:
1. Introductory paragraph=Topic sentence + thesis statement.
A. Topic sentence=first sentence.
· The topic sentence should include your author’s name, plus a listing of their more famous works.
Sample topic sentence:

Lynn Murray is a well known, young adult author who has written a number of books about the little known world of sheep shearing including: Sheep Shearing for Superstars, Watch Out, Young Lamb! and Has Anyone Seen My Wool?  It’s Sure Getting Cold in Here!
B. The last sentence of your introductory paragraph is called a thesis statement.  
1. A thesis statement is a clear statement of your position or argument that you will defend in your paper with supporting evidence from your graphic organizer.  
2. Your thesis statement will list three reasons as to why your chosen author is admirable.   (See page three for possible reasons.)
· Sample thesis statements:

· Based on the multiple obstacles that Lynn Murray has overcome  from childhood, her remarkable educational background spanning nearly three  decades, plus her prolific and captivating body of work concerning the shepherding of Australian short-tailed sheep, many have considered Lynn Murray as one of the most admired and revered authors of her day.
or
· Lynn Murray is an admired and respected author by millions because of the gritty sheep related themes of her books, her love of helping other sheep-inspired writers, and her giving back to the often overlooked sheep shearing community.
2. Body of the paper=paragraphs two, three and four. You will explain each of the reasons listed in your thesis statement in the second, third and fourth paragraphs.  
· Second paragraph=Explain the first reason listed in your thesis statement.

· Use the notes from your graphic organizer to support the first argument in your thesis statement.

· For instance, if you are saying that your author is admirable because they overcame a difficult childhood, use facts from your graphic organizer next to the childhood subtopic to support that.

· You can split the screen so the graphic organizer is on the left and your research paper is on your right.
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· Sample first reason from the sample thesis statement above= “Based on the multiple obstacles that Lynn Murray has overcome from childhood…” 

Sample second paragraph that will explain the obstacles from author, Lynn Murray’s childhood:


Nobody could have foreseen that Lynn Murray would become a successful sheep shearing, young adult writer when she was small.  Lynn grew up in a desert community on the outskirts of Cairo, Egypt.  She lived alone with her beloved, three legged cat named “Lucky” and her one winged pet parrot named “Crash.”  It was in Cairo, however, that Lynn first discovered an abandoned type writer in the end of an alley near the entrance of her hovel. This discovery led to her love of words that spanned nearly four decades. Because Lynn overcame so many challenges as a child and is now a successful young adult author, she serves as an inspiration to millions.
· Third paragraph=Explain the second reason listed in your thesis statement.

· Use your notes from your graphic organizer as evidence to support your argument in your paragraph.
· Fourth paragraph=Explain the third reason listed in your thesis statement.

· Use your notes from your graphic organizer as evidence to support your argument in your paragraph
· Fifth paragraph=Conclusion.

· Restate the reasons from your thesis statement as to why your author is admirable.

Part three: Works Cited page. 

· A Works Cited page is a listing of book and computer sources that you used for research in order to create your paper.

· The Works Cited page is a separate page to be stapled behind the title page and research paper.

· Use Easybib.com to compile your website addresses and book source information to create a
Works Cited page. (See the Sixth Grade Language Arts Research Paper Overview for instructions    

     about how to create a Works Cited page.)
· Sample Works Cited page:
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Works Cited

Harman, Alan. Sheep Magazine | Breeding and Raising Sheep | Sheep Business. Web. 09 May 2011

<http//wwiw.sheepmagazine.com/>|

Sheep 101 Home Page. Web. 09 May 2011. <http://wwww.sheep10Linfo>.

Shepherd, Baabaa. /7orld Book. 2010 ed. Vol. 8. [Chicago, Iil : World Book, 2010. Print.

Lynn Murray, TOR Library/Media Center
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Topic=Author:                      

Research Question:  “Do you admire your chosen author?”

	              Cornell Notes

	              Author’s Early Life

	Subtopics
	                                               Details

	Childhood facts
	· 

	
	· 

	
	· 

	
	· 

	Source: MLA citation, URL or ISBN #
	

	Education
	· 

	
	· 

	
	· 

	
	· 

	Source: MLA citation, URL or ISBN #
	

	Influences to become a writer.
	· 

	
	· 

	
	· 

	
	· 

	Source: MLA citation, URL or ISBN #
	

	Interesting facts that you discovered about your author’s early life.
	· 

	
	· 

	
	· 

	
	· 

	Source: MLA citation, URL or ISBN #
	

	
	

	
	                               Author’s Professional Life

	Books written by your author
	· 

	
	· 

	
	· 

	
	· 

	Source: MLA citation, URL or ISBN #
	

	Sentence summary of each book.
	· 

	
	· 

	
	· 

	
	· 

	Source: MLA citation, URL or ISBN #
	

	Themes of your author’s books.
	· 

	
	· 

	
	· 

	
	· 

	Source: MLA citation, URL or ISBN #
	

	Book reviews. Include quotations.
	· Book review #1=

· Quote from book review:



	Source: MLA citation, URL or ISBN #
	

	
	· Book review #2=

· Quote from book review:

	Source: MLA citation, URL or ISBN #
	

	Summarize your notes here:
	


Your name:  





How to Copy and Paste/Special





Copy and paste/special information from the Internet onto Word.





Copy and paste/special information from the Internet onto Word.





Copy and paste/special information from the Internet onto Word.





Copy and paste/special information from the Internet onto Word.





Highlighted facts from the text on the left are added to the graphic organizer. The website address of the source is pasted directly under the information in the Source box.





Highlighted facts plus the website copied and pasted.





WOW!
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